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Statement of Purpose 
 
 These guidelines have been prepared to help students pursuing formal theological 
education to write with excellence in a proper and orderly fashion (1 Cor 14:4).  The 
following are expansions and summaries of Turabian’s A Manual for Writers, 6th ed., 
Walker and Taylor’s The Columbia Guide to Online Style and The SBL Handbook of 
Style and binding upon all writers of term paper, theses, and dissertations at Calvary 
Baptist Theological Seminary (CBTS) and supersede these works where there is conflict. 
 
 These guidelines are comprehensive, covering all levels of writing at CBTS. 
Writers are expected to adjust their level of compliance with these guidelines to the level 
of the specific project and the expressed criteria given by their professor. 
 
 

Tools For All Writers 
 
Turabian, Kate. L. A Manual for Writers of Term Papers, Theses, and Dissertations. 6th 
ed.  

Chicago: University of Chicago Press, 1996. 
 
Walker, Janice R., and Todd Taylor. The Columbia Guide to Online Style. New York:  

Columbia University Press, 1998. 
 
Webster’s New Universal Unabridged Dictionary. New York, Barns and Noble, 1996. 
 
Brown, Lesley. Ed. The New Shorter Oxford English Dictionary. 4th ed. 2 vols. New 
York:  

Oxford University Press, 1993. 
 
 

Tools For Advanced Writers 
 
Chicago Manual of Style. 14th ed. Chicago: University of Chicago Press, 1993. 
 
Alexander, Patrick H. et al. eds. The SBL Handbook of Style. Peabody, Mass: 
Hendrickson  

Publishers, 1999. 
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Supplement To Turabian’s A Manual for Writers, 6th ed. 
 
 The purpose of this supplement is to point out preferences adopted by Calvary 
Baptist Theological Seminary where Turabian gives options and to add information 
peculiar to CBTS research projects not otherwise addressed in Turabian. Turabian is very 
thorough in its treatment of most issues involving form and style and is rather easy to use. 
One should take the time to closely read the first, fifth, and fourteenth chapters and 
consult the very complete index of topics. 
 
 The following paragraphs have been tagged to the paragraph number in 
Turabian’s 6th ed. where possible. 
 

Research 
 
There are several helpful documents and forms available in the library and on the 
Research Resource CD to aid the student in the various steps of research. 
 
 
Gathering Bibliographic Data 
 
 From the very beginning of research, the student is urged to pay close attention to 
detail when gathering all the necessary bibliographic data. Developing this habit will 
eliminate the last-minute hasty scramble through the library stacks looking for a 
publication date, page numbers, translator’s name, etc. 
 
 Be very careful to record neatly the full name of all authors, editors, and 
translators. When a reprint date must be used (because the copyright date is unknown), 
the footnote and bibliography entry must indicate that fact. Make careful note of the 
names of monograph series and the total volumes in a multi-volume set (and which 
volumes were cited). Be sure to record the inclusive page numbers for an entire periodical 
article. All of this detailed information will be necessary for correct bibliographic entries. 
 
 The student may want to invest in an electronic bibliographic reference tool that 
integrates with their word processor. If the student chooses to make this investment, it is 
recommended that they purchase either ProCite (http://www.procite.com/) or EndNote 
(http://www.endnote.com/). However, if the student is using Nota Bene as their word 
processor it is recommended for them to purchase BookWhere 
(http://www.webclarity.info/products/bookwhere.html). Each of these products has a trial 
version available for download from their website. Please see the Library Director with 
any questions before purchasing any of these products. 
 
 
 



 
 

 

  7 

Documentation 
 
 All papers should be adequately documented. Documentation (i.e. footnoting) 
must not be limited to only those instances of direct quotation. A summary or statement 
of an author’s position, even when reworded by the student, should be documented to 
give credit wherever it is appropriate. The writer is expected to be knowledgeable 
concerning the issues of plagiarism including adequate acknowledgment in the 
paraphrasing and mature borrowing of the thoughts of others. (See Wayne C. Booth, 
Gregory G Colomb, and Joseph M. Williams, The Craft of Research, Chicago: University 
of Chicago Press, 2003, 201-207; 285-288). Remember, frequent quotation is not 
synonymous with good documentation. 
 
 The student should endeavor to locate the most current sources available for their 
topic. For example, when researching lexical support for a Hebrew text, BDB is no longer 
the most current authoritative source; one should consult HALOT. 
 
 
Quotations 
 
(Turabian 5) 
 
 A research paper should be an original critical evaluation and analysis of all 
available data. A major element of a researcher’s task is to evaluate each author and to 
express his view in the researcher’s own words. Do not include quotations just for the 
sake of including quotations. Direct quotations are usually only necessary when an 
author’s exact words are essential to the argument or when a significant thought has been 
expressed particularly well. They should be used very sparingly and only to corroborate 
what the writer has said not to say it for the writer. 
 
 
Bibliography 
 
(Turabian 9) 
 
 The bibliography in a research paper must not be a list of every work the student 
can discover that relates to his topic. It consists of only those sources actually employed 
by the student and which actually contributed to the understanding of the various 
viewpoints relating to the content of the paper. This could include important works 
consulted but not cited by the writer in order to reflect the depth of his research. 
 
 A bibliography should not be divided into sections. All bibliographic items should 
be integrated into one complete alphabetical listing. 
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Secondary Sources 
 
 Do not quote from secondary sources if the original source is available. A thesis 
or dissertation writer should be willing to visit several libraries and use interlibrary loan 
in order to avoid secondary citations. 
 
Electronic Sources 
 
 Verify all electronic text editions in their hard copy or microfilm version when 
possible. See the Supplement to The Columbia Guide to Online Style on page 44 in this 
guide for more information regarding the use of electronic resources. 
 
 
 

Style And Format 
 
(Turabian 2 - 8) 
 
Writing Style 
 
 Use a formal presentation. Avoid references to yourself in the first person, 
including the editorial “we.” Avoid unnecessary use of the second-person pronoun “you.” 
Restructure sentences to avoid overuse of the “this writer” or “the writer.” Do not use 
contractions, clichés, or slang. Avoid unnecessary repetitions by employing synonyms 
and varied expressions. If you are not in the habit of using a thesaurus (paper or 
electronic), begin now. A good electronic thesaurus program (available online and as a 
download) is Visual Thesaurus (www.visualthesaurus.com). 
 
 Avoid unnecessarily long sentences, paragraphs, and sections. As a general rule, if 
a sentence extends longer than three lines, it helps to divide it into two sentences. If a 
paragraph extends longer than a page, it is best to divide it. If a section extends longer 
that three to five pages, subheadings may be useful. Always use introduction or transition 
sentences when employing another level of subheadings to divide the material. 
 
 
Bible Quotations 
 
(Turabian 2.20-21) 
 
 Uses of references to Bible passages in the text of a paper are not abbreviated. 
When the reference is not included in the discussion, but intended as documentation, it 
should be abbreviated and follow the Bible quotation in parentheses (Gen 1:1). This 
reference is part of the sentence and should not be preceded by a period. Note that periods 



 
 

 

  9 

are not used after these abbreviations. All abbreviations should conform to The SBL 
Handbook of Style, pp. 73-75. While Bible quotations are not footnoted, writers should 
state the version they will be quoting unless otherwise noted in a footnote at the first 
biblical quotation in the thesis, dissertation, or term paper. If various versions are quoted, 
they may be individually identified within the text itself. e.g. (Gen 1:1 - NASB). 
 
Abbreviations 
 
(SBL 8.1) 
 
State abbreviations 
 
 (Turabian 2.13)  
 

State abbreviations used in footnotes and bibliographies should not be the two-
letter form used by the Post Office, such as CA and CT, but the more lengthy, easy-to-
recognize abbreviations such as Calif. and Conn.  
 
(Turabian 8.53) 
 

Due to the present international nature of biblical scholarship and electronic 
media, all citations should include state names for all cities except Atlanta, Boston, 
Chicago, Los Angeles, New York, Philadelphia, and San Francisco (note: Grand Rapids 
must be given as Grand Rapids, Mich.). 
 
 
Foreign place name 
 
(Turabian 8.54)  
 

For footnotes and bibliographies, use the form found on the title page. If it says, 
“Roma: Pontificium Institutum Biblicum,” do not substitute “Rome” for “Roma.” 
Country names or abbreviations should be used with all but the major capital cities as 
recognized as New York. (For example: Tokyo may be used without Japan, but Dhaka, 
Bangladesh is required; London may be used alone if it is in England, but London, Ont. is 
required when the Canadian city is intended.) 
 
 
Citations 
 

See the list of commonly used abbreviates found on pages 89 – 152 of The SBL 
Handbook of Style. Any reference used not found on that list must be spelled out in full. 
Refer to page 19 of this guide for more information. 
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Dates 
 
(Turabian 2.56) 
 

To designate an era, use B.C. and A.D. ("before Christ" and "anno Domini") 
instead of B.C.E. and C.E. ("before the common era" and "common era").  B.C. follows 
the year and A.D. precedes it. 
 
 
Numbers 
 
(Turabian 2.29) 
 
  Spell out all numbers up to one hundred and all round numbers that can be 
expressed in two words. 
 
  Specific portions of ancient and medieval writings are to be written in Arabic 
numerals. These are to be separated by a colon for biblical books and a period for all 
other works (e.g., 1 Peter 3:16; Josephus, AJ 11.5.3) 
 
  The table for conveying numbers in sequence correctly, (e.g., continuous 
pages and years), is provided in Turabian 2.67. 
 
 
Division of words 
 
(Turabian 3.35-53) 
 

The specific examples given in Turabian are helpful. In the case of questions, 
check a dictionary. Note especially that a word is never to be divided from page to page. 
Never make a one-letter division. Avoid two-letter divisions. Use only left justification in 
papers and theses. 

 
When dividing a Hebrew phrase or clause between lines, make sure it may be read 

right-to-left consistently. 
 
 
Punctuation 
 
(Turabian 3.63-64 Exclamation point)  

 
Notice that Turabian discourages the overuse of the exclamation point. 
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(Turabian 3.68-72 Series)  
 
Note the condition when three or more elements are given in a series and 

separated by commas. If the last two elements are joined by a conjunction, a comma 
should be used before the conjunction. Example: gold, frankincense, and myrrh. 
 
(Turabian 3.88-90 Colon) 
 

A colon should have two spaces after it when used as a normal punctuation mark. 
 
(Turabian 3.91-97 Dash) 
 

The following is the proper form for a dash in typescript--like the preceding, or 
the long dash (—, em dash) but not -- or - . It consists of 2 typed hyphens or an em dash 
with no space on either side. If the long dash is used, the short dash (–, en dash) should be 
employed in Scripture citations when chapters are included (e.g., Dan 2:4–7:28). 
 
(Turabian 3.98 Parentheses) 
 

Parentheses should also be used in content footnotes such as the following: 
 
Calvin also agrees with this statement (John Calvin, Institutes of the Christian 

Religion [Grand Rapids, Mich.: Wm. B. Eerdmans Publishing Co., 1976], 11). (See 
Turabian 3.99-100 for the use of brackets.) 
 
(Turabian 3.106 Multiple punctuation)  
 

Notice carefully the kinds of punctuation that are to go inside final quotation 
marks and those that go outside. In normal text material, commas and periods always go 
inside any closing quotation marks. This is modern American style. British writings and 
earlier American literature sometimes placed these outside the quotation marks. In 
making block quotations of such sources, the writer should copy the style of the original 
as the punctuation may not be altered except in the case of one-line quotes. 

 
Semicolons and colons always go outside closing quotation marks. 

 
(Turabian 4.14-15 Italics/quotation marks) 
 

Italics used in titles and headings should include all words. Only the titles of 
published materials (such as books, periodicals, newspapers, and magazines) should be in 
italics. Other titles (syllabi, monographs, theses, parts of a published work) should be 
included in quotation marks. 
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It is not proper to use quotation marks for emphasis. The proper way to show 
special emphasis is by italicizing, but the student should avoid the overuse of italics. 
Single quotes may be used in accordance with Turabian 3.107 and 5.16. (Example: “The 
death of God” has been greatly exaggerated.) 
 
 
Spelling and Capitalization 
 
(Turabian 3.1) 
(SBL Appendix A) 
 
 Spelling should agree with the best contemporary American usage (e.g. savior, not 
saviour).  A reliable authority for spelling and word division is Webster’s New Universal 
Unabridged Dictionary or The New Shorter Oxford English Dictionary. 
 
 SBL Appendix A, pages 153-164, offers an authoritative guide to spelling and 
capitalization for biblical studies.  
 
   
Transliterations and Translations 
 
(Turabian 4.28-33) 
 

Transliterations of Greek, Hebrew, and Aramaic words normally are not allowed 
in seminary papers, theses, or dissertations, unless specifically directed by the professor. 
Greek and Hebrew words are not to be italicized or underlined (except when part of a 
book title). Quoted transliterations should be given as in the source being quoted. 
Usually, transliterations are italicized. It is required that Hebrew and Greek words be 
typed. Greek words should be properly accented, and Hebrew words should be accented 
and pointed. 

 
Translations of words or phrases should be done in quotation marks and be 

enclosed in parentheses just following the word or phrase to be translated. [e.g., The 
Hebrew equivalents �� (“in him”) and ����� (“in/by the hand of”) mean the same thing.] 
 
 
Quotations  
 
(Turabian 5.4) 
 

A quotation that is four full lines or more in length and also contains more than 
one sentence (a block quote) must be indented one-half inch from the left margin only and 
single-spaced. Do not indent the first line more unless it is a full paragraph and indented 
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in the source. The right margin of indented quotations should be the same as for the rest 
of the text.  

 
If the quotation is more than four lines, but not more than one sentence, it should 

not be indented. Shorter quotations may be indented only when there is a reason for 
special emphasis, or for consistency (as when quoting a list of several Scripture verses). 
 
Quotations in Footnotes  
 
(Turabian 5.10) 
 

It is not necessary to indent quotations in footnotes. 
 
 
Ellipses  
 
(Turabian 5.18-28) 
 

Ellipses are always three spaced periods with a space before the first and after the 
third. Another punctuation mark may precede or follow. When another punctuation mark 
precedes the ellipsis, it immediately follows the preceding word without a space before it. 
Ellipses are never employed at the beginning of a quotation when the quoted material 
begins a sentence. They are not necessary even when the beginning of the quote is in the 
middle of a sentence in the original source. (It is assumed that the original source is not 
being misrepresented.) Capitalization of the first letter of a quotation may be changed to 
conform to the proper style for the sentence in which it is to be used. 

 
Examples: “An ellipsis may occur in the middle . . . of a sentence.” “An ellipsis 

may occur with a punctuation mark preceding it, . . . when the mark in the text being 
quoted follows the last word before the ellipsis.” “An ellipsis may occur with a 
punctuation mark following it . . ., when the mark in the text being quoted precedes the 
first word after the ellipsis.” The student may supply a period at the end of a complete 
thought even if it is not the end of a sentence in the original. In that case, “the period 
immediately precedes the ellipsis. . . .” 
 
 
Footnotes  
 
(Turabian 8.3) 
 

The font size of footnotes should be the same as the text. 
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Footnote Numbering 
 
(Turabian 8.7–12) 
 
  In theses and dissertations, the numbering of footnotes must begin again at the 
beginning of each chapter. Endnotes may only be used in term papers (with permission of 
the professor), but they are not preferred. In term papers, the numbering of footnotes and 
endnotes should run continuously throughout the paper. 
 
 In MSWord there is a recurring problem with footnotes not appearing on the same 
page where they have been cited within the body of the thesis. Experimentation will 
identify which of the following solutions will work for any given computer or version of 
MSWord. 
 

Option 1: Change the Use Printer Metrics 
 To change the Use Printer Metrics option, follow these steps: 

1. On the “Tools” menu, click “Options,” then select the “Compatibility” tab. 
2. In the “Recommended Options For” list, select your version of MSWord. 
3. Under “Options,” click to change the “Use printer metrics to lay out 
document” check box (if there was a check, clear it; if there was not, enter 
one). 
Note: In most cases, clearing the “Use printer metrics to lay out document” 
check box solves the problem. 
 

Option 2: Change the Line Spacing of the Normal Text to “Exactly” 
Try this method if your document is set to a line spacing other than “Single” (on 
the “Format” menu, click “Paragraph,” and click the “Indents and Spacing” tab). 
Set the line spacing of the normal text of the body to an exact point size. The 
point size depends on your normal font typeface and point size. To modify the 
normal text line spacing, follow these steps: 

1. On the “Edit” menu, click “Select All.” 
2. On the “Format” menu, click “Paragraph.” 
3. Under “Line Spacing,” click “Exactly” and under “AT:” increase the point 
size to the size you want (for a 12 point font typeface, try “Exactly 30 PT”). 
4. Click “OK.” 
 

Option 3: Change the Footnote Paragraph Widow Orphan Control to Off. 
1. On the “View” menu, click “Normal.” 
2. On the “View” menu, click “Footnotes.” Select all the footnotes in the note 
pane. 
3. On the “Format” menu, click “Paragraph.” 
4. Click the “Line and Page breaks” tab, and clear the “Widow/Orphan 
Control” check box. Click “OK.” 
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Option 4: Add and Hide a Custom Footnote Reference and Footnote 
Insert a custom footnote to the right of the offending one, and then format it to be 
hidden. To do this, follow these steps: 

1.  Place the insertion point to the right of the last footnote reference number, 
and then click “Footnote” on the “Insert” menu. 
2.  Under “Numbering,” click to check “Custom Mark,” type an asterisk, and 
then click “OK.” 
3.  Select the new footnote asterisk by pressing SHIFT+HOME. On the 
“Format” menu, click “Font.” Click to select the Hidden check box and then 
click “OK.” 
4.  Select the custom “Footnote Reference” mark in the body of the document, 
and on the “Format” menu click “Font.” Click to select the “Hidden” check 
box and then click “OK.” 

 
The four options described above are permanent and will only change if the writer 

returns the settings back to their former defaults.  
 
 
Date to Use for Citations 
 
(Turabian 8.67-68) 
 

The copyright is the date to use for a book in footnotes and bibliographies. 
Disregard reprinting dates, unless the book has been reprinted by a different publishing 
house, in which case the note should follow the instructions given in 8.46 and 11.20. 

 
 

f. and ff.  
 
(Turabian 8.71) 
 

On rare occasions, it may be permissible to use f. and ff. It is best to use exact 
page numbers. 
 
 
Ibid. 
 
(Turabian 8.84-85) 
 

Ibid. is no longer italicized or underlined, but it always has the period since it is an 
abbreviation (e.g., ibid., 672-74). It is becoming common practice to no longer use Ibid. 
as an abbreviation in footnoted references. The use of Ibid. as an abbreviation in 
footnoted references is not permissible in CBTS research papers, theses, or dissertations. 
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Idem 
 
(Turabian 8.86-87) 
 

The writer may use idem where appropriate. It is no longer italicized or 
underlined. Note that it has no period since it is not an abbreviation. 
 
 
Shortened References 
 
(Turabian 8.88-93) 
 

Use method A (8.90), not method B (8.91). 
 
 
Classical Works 
 
(Turabian 8.119-127) 
 

It is standard to omit all facts of publication for classical works, but they may be 
included when it is advantageous to cite a particular edition: e.g., Pliny, Natural History, 
in vol. 4 of 10 vols., in LCL, 2.1.9. For a general sample use the standard citation, Pliny, 
Natural History, 2.1.9. Note: Arabic numerals are to be preferred to Roman numerals 
when the option exists. 

 
Consult the most recent edition of Oxford Classical Dictionary for accepted 

abbreviations. The overuse of such abbreviations is discouraged. The rule of thumb is to 
make it as easy as possible for a reader to relocate the source. The citation of documents 
from the early church may also take a more complete form. This is especially important 
where English translations are being quoted. The translator and the source of the 
translation should be noted. 

 
Loeb Classical Library or Cambridge Classics editions. 
 

Supra and infra 
 
(Turabian 8.151) 
 

Either “above” or “below” or “supra” or “infra” are acceptable for cross-
references, but the writer should consistently employ either one set or the other. 
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“See” and cf. 
 
(Turabian 8.152) 
 

“See” is an acceptable cross-reference word, but it should not be confused with 
cf., which means “confer,” or cp., which means “compare.” 
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Parts of the Paper 
 
There are three parts of the research paper: preliminaries, text, and references.   
 
 
Preliminaries 
 
(Turabian 1.7-1.32) 
 
  Preliminary pages must follow the order given below.  The only required 
preliminary page for a regular research paper is the title page.  Sample preliminary 
pages are given in Appendix A.  These samples include three separate title pages 
depending upon the nature of the paper. 
 
 Title page 
 Blank page 
 Approval or grade page 
 Dedication (optional) 
 Table of contents 
 List of illustrations 
 List of tables 
 List of abbreviations 
 Acknowledgements (optional) 
 Preface (optional) 
 Abstract 
 
 
Title Page 
 
 The title page should follow the example given on page 52 of these guidelines. The 
title should express in the clearest possible terms the subject matter of the thesis. Avoid 
the extremes of short, cryptic titles and unnecessarily long, ostentatious titles. Proper 
grammar and punctuation should be observed. It is preferable (but not mandatory), that 
Greek and Hebrew words not be used in the title. If they are used, they should not be 
transliterated. 
 
 
Contents 
 
(Turabian 14.19) 
 
 See the sample on page 56 and in Turabian 14.19. Note that subheadings begin with a 
capital letter but are in lower case. Some word processors are capable of generating a 
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table of contents. The table of contents should be reflected as headings in the text of the 
paper. 
 
List of abbreviations 
 
(SBL pgs. 89 – 152) 
 

To determine the appropriate abbreviation in a given situation, the writer should 
consult The SBL Handbook of Style (89-152) or the SBL website (www.sbl-site.org). If 
the work is not found, he may formulate an abbreviation in the first footnote and include 
this formulation in the list of abbreviations used in his thesis. 

 
 Abbreviations for titles of published periodicals and books (including multi-

volume sets of books) are italicized, but series and acronyms of author’s names are not. 
Any paper or thesis using abbreviations must include a list of abbreviations used 
following the contents page. Do not use any abbreviations of names or titles in the 
bibliography. 

 
It is permissible to use common abbreviations in the text of a paper as long as 

these will be readily understood by the anticipated audience. (e.g., OT, NT, LXX, MT, 
NIV, NASB, KJV). 
 
Abstract [theses and dissertations only] 
 
(Turabian 1.32) 
 

The thesis must include an abstract. It will not be mentioned on the contents page. 
It must be limited to one page and may be single-spaced. The margins should be the same 
as for the body of the thesis or dissertation.  

 
An abstract is a one-page capsule statement of the principle areas of investigation, 

main lines of argument, and chief conclusions of the thesis or dissertation. It is a self-
contained summary, not an evaluation or description of the thesis or dissertation. An 
abstract should provide a quick glance at the contents and conclusions of a thesis or 
dissertation. 

 
The following information should be given at the top of the abstract page: title of 

thesis or dissertation, author, degree, date, and adviser(s). The abstract should be arranged 
in paragraphs. The first paragraph should make clear the content of the passage and/or the 
nature of the problem involved. In general, there should be no quotations in the abstract. 
Main lines of argument should be condensed, but it would be improper simply to list 
chapter titles or headings. The principle conclusions of the thesis must be crystal clear in 
the abstract. 
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Text 
 
  The text or main body of the paper is composed of three parts: introduction, 
main body, and the conclusion.  
 
 
Introduction 
 
 In the introduction, the thesis or proposition should be stated succinctly and clearly.  
This is to be followed by a preview of how the paper will be developed and any 
limitations within which the study was made. 
 
 
Chapter titles [theses and dissertation only] 
 

Always use the word “CHAPTER,” a chapter number written out (e.g., “ONE”), 
and a chapter title. Chapters should not be used in brief term papers. 

 
 

Subheadings 
 

The samples on pages 60-61 should be followed.  
 
 
Conclusion 
 
  The conclusion must not include new material or evidence.  It merely 
summarizes the research.  Recommended areas of further investigation are not required. 
 
 
Reference Material 
 
  Various reference material will be included after the main body of the research 
paper or theses.  These may include appendices, endnotes, and the bibliography.  
Appendices include material that is not essential to the main body of the paper but is 
valuable nonetheless.  Endnotes may be used for regular research papers if permitted by 
the instructor.  A bibliography should include all the pertinent sources consulted for 
research.  Sample pages of each are included in appendix A. 
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Typing the Paper 
 
Margins 
 

left:  1-1/2 inches to allow for binding 
right:  1 inch  
bottom: 1 inch  
top of first page of a chapter: 2 inches below the top edge  
top of a full page of text: 1-1/2 inches from the top edge (the page number is one  

inch from the top of the page) 
 

Do not justify right margins. 
 
 
Indentions  
 
 Indentions of paragraphs, footnotes, and bibliographies should be three quarters of an 
inch. 
 
 
Spacing 
 
 The entire text is to be double-spaced; long quotations, footnotes, and the 
bibliography should be single spaced.  Triple space after a chapter title but double space 
after a subheading.  Triple space from the text to any subheading; double-space between 
consecutive subheadings (see pages 60-61 for sample headings page). Do not have a 
single line of a paragraph on one page.  Never end a page with a new heading. 
 
 
Pagination 
 
(Turabian 14.6-7) 
 

Page numbers should be in the upper right-hand corner (one inch from the top); 
however, pages with major headings (e.g. chapters, bibliographies) should have the 
number centered at the bottom (one inch from the bottom) or have no page number at all. 
Be consistent. Numbers are not shown on pages that have no text material (title page, 
blank pages, abstract, and acceptance page). Preliminary pages are numbered with small 
roman numerals (ii, iii, iv, v, etc.) centered at the bottom of the page (one inch from the 
bottom). 
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Major headings and subheadings 
 

See the examples provided in these guidelines (pp. 60-61). A level of headings 
may be skipped if it is done so consistently. Do not use a heading without a parallel 
heading to complement it. Be sure all headings are parallel grammatically. It is very 
important to use transition paragraphs between levels of headings so that a heading never 
directly appears immediately under another heading. 
 
 
Type font size and style 

 
The Times New Roman or Times Roman fonts are required, with a standard 

twelve-point size with five lines per inch spacing (standard settings in Microsoft Word). 
Twelve-point is also mandatory for term papers. Script and other unusual fonts are not 
acceptable. Bold lettering should be used with care. The keyboard page for Times New 
Roman is included in these guidelines to assist the student when using diacritical marks 
and other features of this font (Appendix D). 

 
All research papers, theses, dissertations and daily work are required to use Greek 

and Hebrew fonts that are clear and readable. This is especially important for accents and 
vowel pointing. There are several quality fonts available for this purpose on the Research 
Resource CD. 
  
 
Printer resolution 
 
Theses and dissertations only 

 
Only letter-quality printing with laser technology is acceptable for the presentation 

copy. Ink-jet printing may be used only for draft submissions. 
 
Research papers and daily work 
 
 The use of a dot matrix printer is unacceptable for work being turned in for a 
grade. The use of an Ink-jet printer is sufficient, however the student needs to ensure the 
print quality is high and the ink is consistently clear throughout the paper. 
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Corrections 
 
Because the manuscript will be prepared by computer, all corrections must be 

made using the word processor followed by the printing of a fresh copy up to the time 
presentation copies are submitted. Any page that has noticeable smudges or damage to the 
fiber of the paper must be redone. 
 
 
Paper [theses and dissertation only] 
 
 Use good quality, 25% cotton bond, 20-pound paper. It must be labeled “acid free” or 
“ph neutral” for the final draft and all photocopies presented to the library. 
 
 
Proof-reading 
 
  It is the student's responsibility to prepare his paper in accordance with these 
guidelines before giving it to the typist.  Rereading the paper aloud will help identify 
awkward expressions, incorrect grammar, and typographical errors.  Final draft should be 
written in the third person.  Headings and subheadings should match those in the table of 
contents.  If using a word processor with spell check, have a judicious reliance upon it 
(e.g., you may have written "to" for "too"). 
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Citations: Footnotes, Endnotes & Bibliographies 
 
Type of Notes 
 
  There are two kinds of notes: reference notes and content notes.  Reference 
notes are used to cite either an authoritative source of information or a cross reference.  
Content notes provide added information that relates indirectly to the present discussion 
in the paper. Extensive use of content notes is discouraged. 
 
   
Reference Note Styles 
 
  The standard style for papers and theses is the Traditional Humanities style. 
Parenthetical or, as it is better known, the Author-Date style is only permissible if 
directed by the professor. Brief instructions for each one will be given. 
 
 
Traditional Humanities Style 
 
  For the Traditional Humanities style of documentation, the source of 
information for a book (except for the page numbers) is the title page and the copyright 
page.  For a journal article, it is the title page of the issue and the article itself.  The date 
of publication that appears on the title page is the date to include in the reference note.  If 
this is not present, use the latest copyright date. When no date is given, type “n.d.” If no 
city or publisher is recorded in the source, indicate so by typing “n.p.” Samples of 
different types of documents are given following this section.   
 
  The first line of a footnote should be indented three-quarters of an inch (the 
same as a paragraph indentation.  The order of information for reference notes of a book 
and periodical are given below: 
 
  Author's name in normal order, Title of Book: Other Title Information, editor, 
translator, edition, series (Place: Publisher, date), volume: page(s) cited. 
 
  Author's name in normal order, "Title of the Article," Name of the Journal 
volume in arabic numerals (month year): page(s) cited. 
 

Volume and page numbers. Use Arabic numbers to refer to page and volume 
numbers except when referring to the preliminary pages.  Use lower case roman numerals 
for these. 
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Parenthetical or Author-Date References 
 
(Turabian 10) 
 
  The Parenthetical or Author-Date style of documentation has essentially three 
parts: author, year of publication, and page number that are placed in parentheses 
following the quotation or paraphrase. The full bibliographical record is included in the 
list of sources placed at the end of the paper. Separate publication dates with “a” or “b” to 
separate entries of authors who have written more than one work the same year; for 
example:  
(Smith 1989a, 24). 
 
  This style is only permissible if directed by the professor.  
 
 
Bibliography 
 
  A bibliography is a list of all pertinent sources consulted in writing the paper; 
include it at the end of the paper.  The bibliography begins a new page with the heading 
typed two inches from the top edge of the paper.  Entries must be listed in alphabetical order. 
For bibliographic entries from lexicons and theological dictionaries (e.g., BAGD, TDNT, 
BDB) the writer may enter the work once under the general title rather than each individual 
entry. 
   
  The pages of the bibliography are to be single-spaced with one blank space 
between entries.  The first line is flush left.  Indent subsequent lines of the entry one-half an 
inch.  If the author's name appears more than once in direct sequence, type a continuous line 
three-quarters of an inch long followed by a period.  Give attention to the differences with 
footnotes (e.g., order of author's names and punctuation). For magazine articles that begin in 
the front of a magazine and then skip to the back, cite only the first page. Below is the order 
of the bibliographic information for a book and periodical entry: 
 
Author's full name with surname first. Title of book: Other Information. Editor. Translator. 

Edition. Series. Number of volumes if more than one. Place of publication: 
Publisher, Date. 

 
Author's full name with surname first. "Title of periodical article." Title of Periodical 

Volume in Arabic numerals (Month Year): pages. 
 
  All versions of the Bible used in the paper should have a bibliographical entry.  
The proper form is:  Title: other title information. City: Publisher, Date. 
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Sample Footnotes And Bibliography Entries 
 

Footnotes or endnotes are indicated by N. while bibliography entries are indicated by 
B. The first footnote gives the style for the first citation of a work; the second footnote gives 
the style for the second (and all subsequent) citations. The bibliography entry is left justified 
and then indented. 
 
 
Author’s work translated or edited by another 
 
N. 
 

1Otto Zockler, “The Book of the Prophet Daniel,” trans. and enlarged by James 
Strong, in Commentary on the Holy Scriptures, ed. by John P. Lange (n.p.; reprint, Grand 
Rapids, Mich.: Zondervan Publishing House, 1960), 7:151-52. 
 
 
When the same source is cited in a subsequent footnote, the shortened form should be 
employed: 
 

17Zockler, “Daniel,” 7:160.  
 
B. 
 
Zockler, Otto. “The Book of the Prophet Daniel.” Trans. and enlarged by James Strong. In 

Commentary on the Holy Scriptures. 12 vols. Ed. by John P. Lange, 7:1-273. N.p.; 
reprint, Grand Rapids, Mich.: Zondervan Publishing House, 1960. 

 
N. 
 
 1Walter Eichrodt, Theology of the Old Testament, 2 vols., trans. by J. A. Baker, Old 
Testament Library (Philadelphia: Westminster Press, 1961), 1:27. 
 
B. 
 
Eichrodt, Walter. Theology of the Old Testament. 2 vols. Trans. by J. A. Baker. Old  

Testament Library. Philadelphia: Westminster Press, 1961. 
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N. 
 
 1E. Kautzsch, ed., Gesenius' Hebrew Grammar, 2nd English ed., trans. and rev. by A. 
E. Cowley (Oxford, Eng.: Clarendon Press, 1910), 133. 
 
B. 
 
Kautzsch, E., ed. Gesenius' Hebrew Grammar, 2nd English ed. Trans. and rev. by A. E. 

Cowley. Oxford, Eng.: Clarendon Press, 1910. 
 
 
Separately titled volume in a multi-volume work with a general title and editor 
 

[Note: It is important to distinguish between titles of books (including multi-volume sets, 
e.g. Theological Dictionary of the New Testament) whose titles and abbreviations are 
italicized and titles of series which are not italicized, e.g. Word Biblical Commentary.] 

 
Without a translator: 
 
N. 
 

1James A. Montgomery and Henry Snyder Gehman, A Critical and Exegetical 
Commentary on the Books of Kings, ICC (Edinburgh: T. & T. Clark, 1930), 10-12. 
 

17Montgomery and Gehman, Kings, 16. 
 
B. 
 
Montgomery, James A., and Henry Snyder Gehman. A Critical and Exegetical Commentary  

on the Books of Kings. International Critical Commentary. Edinburgh: T. & T. Clark,  
1930. 
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With a translator: 
 
 The following examples for Keil and Delitzsch are in accord with the two different 
published formats. The first set of examples is for the 25-volume set; the second is for the 
10-volume set. Different publishers handle series differently, using different formats for 
titling. Those differences will determine how the citation is to be handled. 
 
N. 
 

1C. F. Keil and F. Delitzsch, The Pentateuch, 3 vols., trans. by. James Martin, 
Biblical Commentary on the Old Testament (n.p.; reprint, Grand Rapids, Mich.: Wm. B. 
Eerdmans Publishing Company, 1949), 2:399-400. 
 

17Keil and Delitzsch, Pentateuch, 2:341. 
 
B. 
 
Keil, C. F., and F. Delitzsch. The Pentateuch. 3 vols. Trans. by James Martin. Biblical 

Commentary on the Old Testament. N.p.; reprint, Grand Rapids, Mich: Wm. B. 
Eerdmans Publishing Company, 1949. 

 
N. 
 

1C. F. Keil and F. Delitzsch, The Pentateuch, trans. by. James Martin, vol. 1 in 
Commentary on the Old Testament in Ten Volumes (n.p.; reprint, Grand Rapids, Mich.: Wm. 
B. Eerdmans Publishing Company, n.d.), 244. 
 

17Keil and Delitzsch, Pentateuch, 244. 
 
B. 
 
Keil, C. F., and F. Delitzsch. The Pentateuch. Trans. by James Martin. Vol. 1 in 

Commentary on the Old Testament. N.p.; reprint, Grand Rapids, Mich: Wm. B. 
Eerdmans Publishing Company, n.d. 
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Book with one author 
 
N. 
 
 1Hobart E. Freeman, An Introduction to the Old Testament Prophets (Chicago: 
Moody Press, 1968), 46. 
 
 
B. 
 
Freeman, Hobart E. An Introduction to the Old Testament Prophets Chicago: Moody Press,  
 1968. 
 
 
Book with two authors 
 
N. 
 
 1 Martin Bobgan and Deidre Bobgan, The Psychological Way/The Spiritual Way 
(Minneapolis: Bethany House, 1979), 121. 
 
B. 
 
Bobgan, Martin and Deidre Bobgan. The Psychological Way/The Spiritual Way.  

Minneapolis, MN: Bethany House, 1979. 
 
 
Book with three authors 
 
N. 
 1 William La Sor, David Allan Hubbard, and Frederic William Bush, Old Testament 
Survey: The Message, Form, and Background of the Old Testament (Grand Rapids: 
Eerdmans, 1982), 354. 
 
B. 
 
La Sor, William, David Allan Hubbard, and Frederic William Bush. Old Testament Survey:  

The Message, Form, and Background of the Old Testament. Grand Rapids,  
Eerdmans, 1982. 
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Book with more than three authors 
 
N. 
 
 1 Frank Minirth and others, Before Burnout: Balanced Living for Busy People 
(Chicago: Moody Press, 1990), 56. 
 
B. 
 
Minirth, Frank and others. Before Burnout: Balanced Living for Busy People. Chicago:  

Moody Press, 1990. 
 
 

Book in a series 
  
N. 
 

1George P. Hutchinson, The Problem of Original Sin in American Presbyterian 
Theology, An International Library of Philosophy and Theology: Biblical and Theological 
Studies, ed. by Robert L. Reymond (Neptune, N.J.: Presbyterian and Reformed Publishing 
Company, 1972), 97-100. 
 

17Hutchinson, Original Sin, 103. 
 
B. 
 
Hutchinson, George P. The Theological Problem of Original Sin in American Theology. An 

International Library of Philosophy and Theology: Biblical and Theological Studies. 
Ed. by Robert L. Reymond. Neptune, N.J.: Presbyterian and Reformed Publishing 
Company, 1972. 

 
 
Reprint edition 
 

[Note: It is important to include as much information as possible on both the 
original and the reprint edition in hand.] 
  
N. 
 

1Philip Schaff, History of the Christian Church, 8 vols. (New York: Charles 
Scribner’s Sons, 1910; reprint, Grand Rapids, Mich.: Wm. B. Eerdmans Publishing 
Company, 1968), 1:9. 
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B. 
 
Schaff, Philip. History of the Christian Church. 8 vols. New York: Charles Scribner’s Sons, 

1910. Reprint, Grand Rapids, Mich.: Wm. B. Eerdmans Publishing Company, 1968. 
 
 
Component part by one author in a work edited by another 
 
With a commentary: 
 
N. 
 

1J. H. Bernard, “The Second Epistle to the Corinthians,” in Expositor’s Greek 
Testament, ed. by W. Robertson Nicoll (New York: George H. Doran Company, n.d.), 3:78. 
 

17Bernard, “Second Corinthians,” 80. 
 
B. 
 
Bernard, J. H. “The Second Epistle to the Corinthians.” In Expositor’s Greek Testament. Ed. 
by W. Robertson Nicoll, 3:3-119. New York: George H. Doran Company, n.d. 
 
With an essay: 
 
N. 
 

1O. R. Gurney, “Hittite Kingship,” in Myth, Ritual, and Kingship: Essays on the 
Theory and Practice of Kingship in the Ancient Near East and in Israel, ed. by S. H. Hooke 
(Oxford, Eng.: Clarendon Press, 1960), 107. 
 

17Gurney, “Hittite Kingship,” 99. 
 
B. 
 
Gurney, O. R. “Hittite Kingship.” In Myth, Ritual, and Kingship: Essays on the Theory and  

Practice of Kingship in the Ancient Near East and in Israel, ed. by S. H. Hooke, 105- 
21. Oxford, Eng.: Clarendon Press, 1960.  
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N. 
 

1Albert Kirk Grayson, “Assyria: Ashur-Dan II to Ashur-Nirari V (934-745 B.C.),” in 
The Prehistory of the Balkans, and the Middle East and the Aegean World, Tenth to Eighth 
Centuries B.C., 2nd ed., ed. by John Boardman et al., Cambridge Ancient History 3:1 
(Cambridge, Eng.: University Press, 1982), 238. 
 

17Grayson, “Ashur-Dan II to Ashur-Nirari V,” 238. 
 
B. 
 
Grayson, Albert Kirk. “Assyria: Ashur-Dan II to Ashur-Nirari V (934-745 B.C.).” In The 

Prehistory of the Balkans, and the Middle East and the Aegean World, Tenth to 
Eighth Centuries B.C., 2nd ed. Ed. by John Boardman et al., 238-81. Cambridge 
Ancient History 3:1. Cambridge, Eng.: University Press, 1982. 

 
 
Article in a journal 
 
In a foreign language: 
 
N. 
 

1Helga Weippert, “Das geographische System der Stämme Israels,” Vetus 
Testamentum 23 (1973): 77. 
 
[Note that capitalization follows the rules of the language in which the article is written (in 
this case, German).] 
 

17Weippert, “Das geographische System,” 79. 
 
B. 
 
Weippert, Helga. “Das geographische System der Stämme Israels.” Vetus Testamentum 23  

(1973): 76-98. 
 
In English: 
 
N. 
 

1O. Linton, “Coordinated Sayings and Parables in the Synoptic Gospels: Analysis 
Contra Theories,” New Testament Studies 26 (Jan 1980): 140. 
 

17Linton, “Coordinated Sayings,” 142. 
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B. 
 
Linton, O. “Coordinated Sayings and Parables in the Synoptic Gospels: Analysis Contra  

Theories.” ew Testament Studies 26 (Jan 1980): 139-63. 
 
 
 
Article in a magazine 
 
N. 
 

1William M. Kinnaird, “Divorce and Remarriage: Ministers in the Middle,” 
Christianity Today 24/11 (June 6, 1980): 24. 
 

17Kinnaird, “Divorce and Remarriage,” 26. 
 

B. 
 
Kinnaird, William M. “Divorce and Remarriage: Ministers in the Middle.” Christianity  

Today 24/11 (June 6, 1980): 24-27. 
 
 
Articles in encyclopedias, dictionaries, and lexicons 
 
With a list of abbreviations: 
 
N. 
 

1BDB, 345. 
 

2Ibid., 82. 
 
Without a list of abbreviations: 
 
N. 
 
 1Francis Brown, S. R. Driver, and C. A. Briggs, eds., A Hebrew and English Lexicon 
of the Old Testament (Oxford, Eng.: Clarendon Press, 1968), 345. 
 
 17Brown, Driver, and Briggs, Lexicon, 348. 
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B. 
 
Brown, Francis, S. R. Driver, and C. A. Briggs, eds. A Hebrew and English Lexicon of the  

Old Testament. Oxford, Eng.: Clarendon Press, 1968. 
 
 
With a list of abbreviations: 
 
N. 
 

1KB2, 92. 
 

2Ibid., 12. 
 
[Note: The superscript number following the standard abbreviation indicates the edition 
number of the work. No superscript indicates a first edition.] 
 
 
Without a list abbreviations: 
 
N. 
 
 1Ludwig Koehler and Walter Baumgartner, eds., Lexicon in Veteris Testamenti 
Libros, 2nd ed. (Leiden, The Netherlands: E. J. Brill, 1958), 92. 
 
B. 
 
Koehler, Ludwig, and Walter Baumgartner, eds. Lexicon in Veteris Testamenti Libros, 2nd  

ed. Leiden, The Netherlands: E. J. Brill, 1958. 
 
N. 
 
 1Ludwig Koehler and Walter Baumgartner, eds., The Hebrew and Aramaic Lexicon 
of the Old Testament, 5 vols., rev. by Walter Baumgartner and Johann Jakob Stamm, trans. 
and ed. by M. E. J. Richardson (Leiden, The Netherlands: E. J. Brill, 1994), 1:92. Hereafter, 
HALOT. 
 
 17HALOT, 2:148. 
 
B. 
 
Koehler, Ludwig, and Walter Baumgartner, eds. The Hebrew and Aramaic Lexicon of the  

Old Testament. 5 vols. Rev. by Walter Baumgartner and Johann Jakob Stamm.  
Trans. and ed. by M. E. J. Richardson. Leiden, The Netherlands: E. J. Brill, 1994. 
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N. 
 

1William L. Holladay, A Concise Hebrew and Aramaic Lexicon of the Old Testament 
(Grand Rapids, Mich.: Wm. B. Eerdmans Publishing Company, 1971), 74. 
 

17Holladay, Lexicon, 64. 
B. 
 
Holladay, William L. A Concise Hebrew and Aramaic Lexicon of the Old Testament. Grand 
 Rapids, Mich.: Wm. B. Eerdmans Publishing Company, 1971. 
 
N. 
 

1Marcus Jastrow, comp., A Dictionary of the Targumim, the Talmud Babli, and 
Yerushalmi, and the Midrashic Literature, 2 vols. (n.p., 1923; reprint, Brooklyn, N.Y.: P. 
Shalom Publishing Inc., 1967), 1:26. 
 

17Jastrow, Dictionary, 2:93. 
 
B. 
 
Jastrow, Marcus, comp. A Dictionary of the Targumim, the Talmud Babli, and Yerushalmi,  

and the Midrashic Literature. 2 vols. N.p., 1923; reprint, Brooklyn, N.Y.: P. Shalom  
Publishing Inc., 1967. 

 
[Note: The date of the original edition should be included in the reprint statement if it is 
known.] 
 
 
With a list of abbreviations: 
 
N. 
 

1BAGD, 71. 
 

2Ibid., 78. 
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Without a list of abbreviations: 
 
N.  
 
 1Walter Bauer, William F. Arndt, and F. Wilbur Gingrich, A Greek-English Lexicon 
of the New Testament and Other Early Christian Literature, 2nd ed., rev. and augmented by 
F. Wilbur Gingrich and Frederick W. Danker (Chicago: University of Chicago Press, 1979), 
71. 
 
B. 
 
Bauer, Walter, William F. Arndt, and F. Wilbur Gingrich. A Greek-English Lexicon of the  

New Testament and Other Early Christian Literature, 2nd ed. Rev. and augmented  
by F. Wilbur Gingrich and Frederick W. Danker. Chicago: University of Chicago  
Press, 1979. 

 
[Note: The latest edition of BDAG should be used in preference to the earlier one, unless 
specific comparisons are being made.] 
 
 
With a list of abbreviations: 
 
N. 
 

1LSJ, 98. 
 
 
Without a list of abbreviations: 
 
N. 
 

1Henry George Liddell and Robert Scott, comps., A Greek-English Lexicon, rev. and 
augmented by Henry Stuart Jones with the assistance of Roderick McKenzie et al., with a 
supplement (Oxford, Eng.: Clarendon Press, 1968), 98.  
 
B. 
 
Liddell, Henry George, and Robert Scott, comps. A Greek-English Lexicon. Rev. and  

augmented by Henry Stuart Jones with the assistance of Roderick McKenzie et al.,  
with a supplement. Oxford, Eng.: Clarendon Press, 1968. 

 
 
 
 



 
 

 

  37 

N. 
 

1Paul D. Wegner, “Ruth, Theology of,” in Evangelical Dictionary of Biblical 
Theology, ed. by Walter A. Elwell (Grand Rapids, Mich.: Baker Book House, 1996), 695. 
 
B. 
 
Wegner, Paul D. “Ruth, Theology of.” In Evangelical Dictionary of Biblical Theology. Ed.  

by Walter A. Elwell, 694-96. Grand Rapids, Mich.: Baker Book House, 1996.  
 
 
When no author information is available: 
 
N. 
 
 1Dictionary of the Bible, s.v. “Marah,” 577.  
 
B. 
 
Hastings, James, ed. Dictionary of the Bible. New York: Charles Scribner’s Sons, 1924.  
 
________. S.v. “Marah,” 577-78. 
 
N. 
 

1 J. Jeremias, “������,” TDNT, 4:269-70. 
 
B. 
 
Jeremias, J. “������.” In Theological Dictionary of the New Testament. 10 vols. Ed. 
by  

Gerhard Kittel. Trans. and ed. by Geoffrey W. Bromiley, 4: 268-80. Grand Rapids,  
Mich.: Wm. B. Eerdmans Publishing Co., 1967. 

 
N. 
 

1 Rolf Rendtorff, “� � �	 
 �� 
 �, ���	
�,” TDNT, 6:796. 
 
B. 
 
Rendtorff, Rolf. “� � �	 
 �� 
 �, ���	
�.” In Theological Dictionary of the New 
Testament. 10  

vols. Ed. by Gerhard Kittel. Trans. and ed. by Geoffrey W. Bromiley, 6:781-861.  
Grand Rapids, Mich.: Wm. B. Eerdmans Publishing Co., 1968. 
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Book reviews 
 
N. 
 

1Charles R. Smith, review of Tongues of Men and Angels, by William J. Samarin, 
Grace Journal 14 (1973): 39-41. 
 

17Smith, “Review,” 39. 
 
 
 
B. 
 
Smith, Charles R. Review of Tongues of Men and Angels, by William J. Samarin. Grace  
 Journal 14 (1973): 39-41. 
 
 
Theses or Dissertation 
 
N. 
 
 1Gordon Henry Lovik, "Expressing Time in the Gospels" (Th.D. diss., Grace 
Theological Seminary, 1973), 84. 
 
B. 
 
Lovik, Gordon Henry. "Expressing Time in the Gospels." Th.D. diss., Grace Theological  
 Seminary, 1973. 
 
Secondary quotation 
 
(Use only if the original is not available.) 
 
N. 
 
 1 Jacques Maritain, Moral Philosophy (New York: Scribners, 1964), 94; quoted in 
George William Rutler, Christ and Reason: An Introduction to Ideas from Kant to Tyrrell 
(Front Royal, Va.: Christendom Press, 1990), 9, n. 6. 
 
B. 
 
Maritain, Jacques. Moral Philosophy. New York: Scribners, 1964, 94. Quoted in George  
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 William Rutler. Christ and Reason: An Introduction to Ideas from Kant to Tyrrell, 9, n.  
 6. Front Royal, Va.: Christendom Press, 1990. 
Talmud  
 
N. 
 
 1 Babylonian Talmud Sanhedrin 74a.  (or)   b. Sanh. 74a. 
 
B. 
 
The Babylonian Talmud. Edited by Isadore Epstein. London: Soncino Press, 1948. 
 
 
Tosepta  
 
N. 
 1 Tosepta Hagigah 3.35.     (or)     t. Hag. 3.35. 
 
B. 
 
The Tosefta. Translated by Jacob Neusner. New York: KTAV Publishing House, 1979. 
 
 
Mishnah  
 
N. 
 
 1 Mishnah Berakot 9.5.    (or)    m. Ber. 9.5. 
 
B. 
 
The Mishnah. Translated by Herbert Danby. London: Oxford University Press, 1933. 
 
 
Qumran  
 
N. 
 
 1 Temple Scroll 64.6b.    (or)     IIQTemple 64.6b. 
 
B. 
 
The Dead Sea Scrolls: In English. Translated by Geza Vermes. 3rd ed. Sheffield,  England:  
 JSOT Press, 1987. 
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Classical Works 
 
 (Any of the following forms are acceptable) 
 
N. 
 
 1 Thucydides History of the Peloponnesian War 5.16.3.  (or) Thuc. 5.16.3. (or) 
 
 1 Thucydides History of the Peloponnesian War, vol. 3, Loeb Classical Library, 31. 
 
 
B. 
 
Thucydides History of the Peloponnesian war. Vol. 2, trans. Charles Forster Smith. Loeb  
 Classical Library. London: William Heinemann, 1920. 
 
 
Class Lecture (Notes Printed In Syllabus) 
 
N. 
 
 1 Warren Vanhetloo, "OT Biblical Theology" (unpublished class notes in 231 Old 
Testament Biblical Theology, Calvary Baptist Theological Seminary, Fall 1991), 13. 
 
B. 
 
Vanhetloo, Warren. "OT Biblical Theology." Unpublished class notes in 231 Old Testament  
 Biblical Theology. Calvary Baptist Theological Seminary, Fall 1991. 
 
 
Class Lecture (Notes From Lecture) 
 
N. 
 1 Warren Vanhetloo, class notes of student in 231 Old Testament Biblical 
Theology, Calvary Baptist Theological Seminary, Fall 1991. 
 
B. 
 
Vanhetloo, Warren. 1991. Class notes of student in 231 Old Testament Biblical Theology.  
 Calvary Baptist Theological Seminary. 
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Published Recordings On Audiocassette 
 
N. 
 1 Cornelius Van Til, Augustine (Philadelphia: Westminster Media, n.d.), 
audiocassette. 
 
B. 
 
Van Til, Cornelius. N.d. Augustine. Philadelphia: Westminster Media. Audiocassette. 
 
 
 
Unpublished Recordings On Audiocassette 
 
N. 
 
 1 David Burggraff, "Contemporary Dispensationalism" (Calvary Baptist 
Theological Seminary, 1992), audiocassette. 
 
 
B. 
 
Burggraff, David. "Contemporary Dispensationalism." Calvary Baptist Theological  
 Seminary, 1992. Audiocassette. 
 
 
Unpublished Paper 
 
N. 
 
 1 Renald Showers, "Pre-Tribulation Rapture," TD [photocopy], n.d., Calvary 
Baptist Theological Seminary Library, Lansdale, PA, 23. 
 
B. 
 
Showers, Renald. "Pre-Tribulation Rapture." TD [photocopy], n.d., Calvary Baptist  
 Theological Seminary Library, Lansdale, PA. 
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Multiple References In A Single Note 
 
N. 
 
(This example only applies to a note. Both references cited would have to be entered 
separately in the bibliography.) 
 
 1 See F.F. Bruce, New Testament History (Garden City, NY: Doubleday-Galilee, 
1980), 64; and Joachim Jeremias, Jerusalem in the Time of Jesus, trans. F. H. Cave and C. 
H. Cave (Philadelphia: Fortress, 1975), 159. 
 
 
Videocassette 
 
N. 
 1 John Gray, Men are from Mars, Women are from Venus. Produced by American 
Broadcasting Companies, Inc. 120 min. 1996. Videocassette. 
 
B. 
 
Gray, John, Men are from Mars, Women are from Venus. Produced by the American  
 Broadcasting Companies, Inc. 120 min. 1996. Videocassette. 
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Citation Of Electronic Publications – Supplement to The Columbia Guide to Online Style 
 

Students must hedge against the volatile nature of online documents, as they will 
often vanish without notice. To do this, students must not rely on hypertextual links to refer 
to sources on the WWW, and they should store all cited documents in an electronic file or in 
printed form. Note: Recently published online editions of standard works are useful for 
searching however, the hard copy edition should be used for citation in term papers, theses, 
and dissertations. Thesis and dissertations should cite the hard copy edition of an 
electronically published work wherever possible. 

 
 
The components of a URL are as follows: 
 
URL: http://www.bible.org/docs/soapbox/2pet310.htm: 
 

• http://    designates the protocol (Hypertext Transfer Protocol). 
 

• www.bible.org    is the domain with org standing for a non-profit organization. 
 

• /docs & /soapbox    is a directory (or subdirectory) 
 

• /2pet310.htm    is a file name. 
 
URLs must be copied with the greatest of accuracy as any variation can prevent access.  
 
 
Basic Citation Format (components and punctuation) 
 
Author’s Last Name, First Name. “Title of Document.” Title of Complete Work [if 
applicable]. Version or File Number [if applicable]. Document date or date of last revision 
[if different from access date]. Protocol and address, access path or directories (date of 
access).  
 
This basic format should be used as a template for citing various electronic documents as the 
following examples demonstrate. Students should note that the guidelines of Turabian are 
being translated to fit the unique elements of electronic files (e.g., months are abbreviated as 
per Turabian 2:55). The many examples of various conditions within file types in the 
Columbia Guide are very helpful, however, they are translating MLA (Modern Language 
Association) and APA (American Psychological Association) style guides and will need 
some adjustment to fit with Chicago style (Turabian). 
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Sample Bibliography and Footnote Entries 

 
 
The World Wide Web (WWW) 
 
Basic format (Walker & Taylor, 45). 
 
Author’s Last Name, First Name. “Title of Document or File.” Title of Complete Work or 
Site. Version or file number. Date of document. Protocol and address (date of access). 
 
N.  
 

1 Daniel B. Wallace, “A Brief Note On a Textual Problem in 2 Peter 3:10,” 2003, 
http://www.bible.org/docs/soapbox/2pet310.htm (23 July 2004). 
 
B. 
 
Wallace, Daniel B. “A Brief Note On a Textual Problem in 2 Peter 3:10,” 2003.  

http://www.bible.org/docs/soapbox/2pet310.htm (23 July 2004). 
 
 
Discussion Lists, Usenet Newsgroups, and Email 
 
Basic format (Walker & Taylor, 66). 
 
Author’s Last Name, First Name or alias. “Subject Line.” Message date if different from 
date accessed. List Name [if applicable]. List or newsgroup address (date accessed). 
 
 
Listservs, etc. 
 
N.  
 

1 Joe Fleener, “How to Use BibleWorks,” bibleworks@topica.com (12 June 2002). 
 
B.  
 
Fleener, Joe. “How to Use BibleWorks.” bibleworks@topica.com (12 June 2002). 
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Newsgroups and Usenet group messages. 
 
N. 
 

1 James Rosscup, “[ED TECH] EMG: Sacred Texts (Networked Electronic 
Versions),” alt.etext, jrosscup@tms.edu (4 Feb. 1993). 
 
B.  
 
Rosscup, James “[EDTECH] EMG:Sacred Texts (Networked Electronic Versions).”  

alt.etext .jrosscup@kathab.tms.edu (4 Feb. 1993). 
 
 
Email. 
 
N.  
 

1 Joe Fleener, “Answers to Exam.” 23 July 2004. jfleener@cbs.edu (23 July 2004). 
 
B.  
 
Fleener, Joe. “Answers to Exam.” 23 July 2004. jfleener@cbs.edu (23 July 2004). 
 
 [Note: a personal email would omit the email address and insert [personal email] in its 
place.] 
 
 
Gopher Sites, File Transfer Protocols (FTP), and Telnet Protocols 
 
Basic format (Walker & Taylor, 72, 75, 82). 
 
Author’s Last Name, First Name. ‘Title of Work.” Title of Complete Work. Date of 
document. Protocol and address, path or directories (date of access). 
 
 
Gopher site 
 
N. 
 

1 H. Van Dyke Parunak, “Code Manual for the Michigan Old Testament,” 19 Mar. 
1982, Gopher://ccat.sas.upenn.edu:3333/00/Religious/Biblical/MBHS/002.MichiganManual 
(14 Aug. 1999). 
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B. 
 
Parunak, H. Van Dyke. “Code Manual for the Michigan Old Testament.” 19 Mar. 1982. 

Gopher://ccat.sas.upenn.edu:3333/00/Religious/Biblical/MBHS/002.MichiganManual 
(14 Aug. 1999). 

 
 
FTP protocol 
 
N. 
 

1 Nigel Strudwick, “News from Luxor,” 16 Jan. 1995, ftp://newton.newton.cam. 
ac.uk/pub/ancient/egypt/LUXOR.TXT (14 Aug. 1999). 
 
B.  
 
Strudwick, Nigel. “News from Luxor.” 16 Jan. 1995. ftp://newton.newton.cam.ac.uk/pub/ 

ancient/egypt/LUXOR.TXT (14 Aug. 1999). 
 
 
Telnet Protocol: see above examples as these are treated largely the same as Gopher and 
FTP sites.  
 
 
Online Reference Source 
 
Basic format (Walker & Taylor, 92). 
 
Author’s Last Name, First Name. “Title of Article,” Title of Complete Work. Previous 
publication information and date. Online edition. Online Service or protocol and address and 
any paths or directories (date accessed). 
 
N. 
 

1 Anthony F. Beavers, “A Chronology of the Arian Controversy,” The Ecole 
Initiative, Online ed., http://ceder.evansville.edu/eco/eweb/arians/arianchr.htm (13 Aug. 
1999). 
 
B. 
 
Beavers, Anthony F. “A Chronology of the Arian Controversy.” The Ecole Initiative. 

Online ed. http://ceder.evansville.edu/eco/eweb/arians/arianchr.htm (13 Aug. 1999). 
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Electronic Publications and Online Databases 
 
Basic format (Walker & Taylor, 96). 
 
Author’s Last name, First Name. “Title of Article.” Title of Software Publication. 
Publication information, including version or edition number, if applicable, and date of 
publication. Name of database, if applicable. Name of online service or Internet protocol and 
address. File or version number or other identifying information and directory path (date 
accessed).  
 
 
CD-ROM, diskette, etc. 
 
N. 
 

1 Eric W. Hyden, “Highlights in the Life of Charles Haddon Spurgeon,” The C.H. 
Spurgeon Collection, The Ages Digital Library (14 Aug. 1999). 
 
B. 
 
Hyden, Eric W. “Highlights in the Life of Charles Haddon Spurgeon.” The C.H. Spurgeon 

Collection, The Ages Digital Library (14 Aug. 1999). 
 
 
General Citation for an Electronic Concordance Program 
 
N. 
 
 1 Michael S. Bushell and Michael D. Tan, BibleWorks 6.0.009i (BibleWorks, 2003). 
 
B. 
 
Bushell, Michael S. and Michael D. Tan. BibleWorks 6.0.009i BibleWorks, 2003. 
 
 
Citation for a Text Module from an Electronic Concordance Program 
 
N. 
 
 1 Martin G. Abegg Jr., “The Qumran Sectarian Manuscripts (with Morphological 
Tags) 1999, 2000, 2001,” BibleWorks 6.0.009i (BibleWorks, 2003). 
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B. 
 
Abegg, Martin G. Jr. The Qumran Sectarian Manuscripts (with Morphological Tags). 1999,  

2000, 2001. BibleWorks 6.0.009i BibleWorks, 2003. 
 
N. 
 

1 Alan Groves and Wheeler, “Groves-Wheeler Westminster Morphology and Lemma 
Database (WTM), Release 3.5. 2001,” BibleWorks 6.0.009i (BibleWorks, 2003). 
 
B. 
 
Groves, Alan and Wheeler. Groves-Wheeler Westminster Morphology and Lemma Database  

(WTM), Release 3.5. 2001. BibleWorks 6.0.009i BibleWorks, 2003. 
 
N. 
 
 1 Michaels S. Bushell, Jean-Noel Aletti and Andrzej Gieniusz, “BibleWorks Greek 
New Testament Morphology (BNM). 1999-2001,” BibleWorks 6.0.009i (BibleWorks, 2003). 
 
B. 
 
Bushell, Michael S., Jean-Noel Aletti and Andrzej Gieniusz. BibleWorks Greek New  

Testament Morphology (BNM). 1999-2001. BibleWorks 6.0.009i BibleWorks, 2003. 
 
 
Citation for a Lexicon Module from an Electronic Concordance Program 
 
N. 
 
 1 BDAG, BibleWorks 6.0.009i (BibleWorks, 2003). 
 
B. 
 
Bauer, W., F. W. Danker, W. F. Arndt, and F. W. Gingrich. Greek-English Leixcon of the  

New Testament and Other Early Christian Literature. 3d ed. Chicago, 1999.  
BibleWorks 6.0.009i BibleWorks, 2003. 

 
N. 
 
 1 HALOT, BibleWorks 6.0.009i (BibleWorks, 2003). 
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B. 
 
Keohler, L., W. Baumgartner, and J. J. Stamm, The Hebrew and Aramaic Lexicon of the Old  

Testament. Leiden, 1994-1999. BibleWorks 6.0.009i BibleWorks, 2003. 
 
 
 
Computer information services and online databases 
 
N. 
 

1 Mary Ann Shisler, “The Mennonites and Their Contribution to World Peace,” 
AskEric InfoGuide, Nov. 1998, http://ericir.syr.edu/plweb-cgi/fastweb?getdoc+infoguides+ 
265+0+wAAA+old%26testament. 
 
B. 
 
Shisler, Mary Ann. “The Mennonites and Their Contribution to World Peace.” AskEric Info 

Guide. Nov. 1998. http://ericir.syr.edu/plweb-gi/fastweb?getdoc+infoguides+265+0+ 
wAAA+old%26testament. 

 
[Note: Some URLs will incorporate math symbols and punctuation as in the example above. 
Remember to be accurate in copying all URLs. Such unique URLs may not be reaccessible, 
making the citation useless for future follow-up. Online sources remain somewhat unstable, 
therefore the writer should print out and file online works that they use in research 
(especially those they cite).]
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APPENDIX A: Sample 
Pages 
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 [sample page] 

 
 
 
 

THE WORK OF THE HOLY SPIRIT IN THE  
 

BOOK OF JUDGES 
 
 
 
 
 
 
 
 
 
 
 
 
 
 by 
 
 John A. Smith 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Submitted in partial fulfillment of requirements 
for the course Joshua-Judges-Ruth 245 

Dr. Charles E. McLain 
Calvary Baptist Theological Seminary 

May 2001 
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[sample page] 
 
 

THE PRINCIPLES OF DISCIPLINE IN 
 

MATTHEW 18:15-17 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

by 
 

David L. Burggraff 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Submitted in partial fulfillment of requirements 
for the degree Master of Theology 

Calvary Baptist Theological Seminary 
May 1988 
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[sample page] 
 
 

CONQUERING THE FEARS THAT 
 

PREVENT MINISTRY 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

by 
 

William E. Adams 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Submitted in partial fulfillment of requirements 
for the degree Doctor of Ministry 

Calvary Baptist Theological Seminary 
May 1990 
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[sample page] 
 
 

THE PRINCIPLES OF DISCIPLINE IN 
 

MATTHEW 18:15-17 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Accepted by the Faculty of the Calvary Baptist Seminary in partial fulfillment of the 
requirements for the degree 

 
Master of Theology 

 
 

        Date                          
 
        Grade                
 
 
 
         Examining Committee 
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[sample page - at least 1 inch top margin] 
 

TABLE OF CONTENTS 
 
 
PREFACE . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ii 
 
LIST OF TABLES . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . iv 
 
ABSTRACT   . . . . .  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .v 
 
INTRODUCTION . .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1 
 
Chapter 
 
   1. THE FEARS OF BELIEVERS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 
 
      The Impact of Fear upon Local Church  
      Ministry Today 
      The Impact of Fear upon Timothy's Ministry 
      The Impact of God's Message upon Fear 
 
2. THE FUNDAMENTALS FOR A COUNSELOR . . . . . . . . . . . . . . . . . . . . . . . . . . 13 
 
   Implications for the Counselor 
   Implications for the Counselee 
 
3. THE FORMULATION OF POWER . . . . . . . . . . . . . . . . . . . . . . . . . . .. . . . . . . . . 36 
 
   The Establishment of Power 
   The Maintenance of Power 
   The Counseling Implications of Power 
 
4. THE FOCUS ON LOVE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56 
 
   The Scriptural View 
   The Upward View 
   The Outward View 
   The Inward View 
 
5. THE FUNCTION OF A SOUND MIND . . . . . . . . . .  . . . . . . . . . . . . . . . . . . . . . . 89 
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 Top Margin at least 2 inches 
 If short, center top to bottom 
 
 
 
 
 
 
 
 
 
 
 
 [center heading] 
 
 LIST OF ILLUSTRATIONS 
[2 blank lines] 
 
1.  Survey Statistics: Comparative Study of Response 
       and No Response to Questionnaire .....................................................................  153 
 
2.  Total Returned Surveys: Counseling DS or Other 
       Disabilities ..........................................................................................................  154 
 
3.  Returned Surveys: DS Counseled vs. No Response .............................................  156 
 
4.  Demographic Comparisons: Counseled DS vs. Not 
       Counseled DS......................................................................................................  158 
 
5.  Down Syndrome Awareness: Ideal Compared to 
       Questionnaire Results .........................................................................................  159 
 
6.  Lecture Group Pre vs. Post: Video Tape Lecture Results.....................................  170 
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 Top Margin at least 2 inches 
 If short, center top to bottom 
 
 
 
 
 
 
 
 
 

[center heading] 
 

LIST OF TABLES 
[2 blank lines] 
 
1.  Growth Enrichment Marital Seminar Attendance Record..............................268 
 
2.  Waring Intimacy Questionnaire: Control:  
       Pre vs. Post....................................................................................................272 
 
3.  Waring Intimacy Questionnaire: Seminar: 
       Pre v. Post .....................................................................................................273 
 
4.  Pair Intimacy Questionnaire: Control: 
       Pre vs. Post....................................................................................................276 
 
5.  Pair Intimacy Catenary: Seminar: 
      Pre vs. Post.....................................................................................................277 
 
6.  Gems Intimacy Questionnaire: Control: 
       Pre vs. Post....................................................................................................281 
 
7.  Gems Intimacy Questionnaire: Seminar: 
       Pre vs. Post....................................................................................................282 
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 [Sample page] 
 
 
 LIST OF ABBREVIATIONS 
 
 
AB  Anchor Bible 
 
AJP  American Journal of Philology 
 
ANETP  Ancient Near Eastern Supplementary Texts and Pictures 
 
BADG  Greek-English Lexicon of the New Testament and Early Christian Literature 
 
BASOR  Bulletin of the American Schools of Oriental Research 
 
CBQ  Catholic Biblical Quarterly 
 
HeyJ  Heythrop Journal 
 
ICC  International Critical Commentary 
 
ISBE  International Standard Bible Encyclopedia 
 
JETS  Journal of the Evangelical Theological Society 
 
JQR  Jewish Quarterly Review 
 
KJV  King James Version 
 
NovTSup Novum Testamentum Supplements 
 
PEQ  Palestine Exploration Quarterly 
 
RevQ  Revue de Qumran 
 
SSNTSMS Society for New Testament Study Monograph Series 
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 [Sample headings] 
  
 
 CHAPTER I 
 
 CHAPTER TITLE 
 
 
  Use a two-inch margin at the top where a new chapter begins, otherwise use a 

margin of at least one inch at the top.  Centered headings should not be more than 48 spaces; 

if so, divide in an inverted pyramid using double spacing. 

 
 First Level Subheading 
 
  First level subheading should be bold and centered. Triple-space after chapter 

title but double-space after sub-headings.  Triple-space from text to sub-heading. 

 
 Second Level Subheading 
 
  Use uppercase for the first letters in each word; do not use bold or underscore,  
 
but center the text. 
 
 
Third Level Subheading [is bold and left justified. Triple-space before all subheadings] 
 
 
Fourth level subheading 
 
  Double-space between consecutive sub-headings.  Do not use bold or italics, 

should be left justified. Use uppercase for first word in heading as well as for proper names 

for fourth and fifth level subheadings.  
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  Fifth level heading.  This heading indented to the paragraph indentation, 

italicized and followed by a period.  All five headings need not be used; however, those used 

must follow in descending order. 
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 [Sample Footnotes] 

 This page lists samples of the approved footnote style.  When citing material 

from a multi-volume source, cite the title of the work within quotation marks when it does 

not comprise the complete volume, but italicize it when it does.1  When a source is the 

publication of a series, the series title is included but not underlined.2  A series title is "an 

ongoing project of its sponsors, whose purpose is the issuance from time to time of books or 

pamphlets by different writers on topics . . . over a specific field"  (Turabian, 9.49). 

 Notice the different ways to abbreviate long titles when citing them more than 

once.3  Use "Ibid." when citing the same source in immediate sequence.4  

  

                                                 
1Otto Zocker, "The Book of the Prophet Daniel" (hereafter referred to as 

"Daniel"), trans. James Strong, in Commentary on the Holy Scriptures, ed. John P. Lange, 
new ed. (Grand Rapids: Zondervan Publishing House, 1960), 7:151-152. 

 
2George W. Knight. The Pastoral Epistle: A Commentary on the Greek Text. 

The New International Greek Testament Commentary, ed. I. Howard Marshal and W. Ward 
Gasque (Grand Rapids: Eerdmans, 1992), 37. 

 
3Zockler, "Daniel," 153-161. 

4Ibid., 21-22. 
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[Sample bibliography] 
 

[2 inch top margin for initial page] 
 
 
Bloom, Harold. The American Religion: The Emergence of the Post-Christian Nation. New 

 York: Simon & Schuster, 1992. 
 
Bobgan, Martin and Deidre Bobgan. The Psychological Way/The Spiritual Way. 

Minneapolis, Minn.: Bethany House, 1979. 
 
Bright, John. A History of Israel. 3rd ed. Philadelphia: Westminster Press, 1981. 
 
Eadie, John. Commentary on the Epistle of Paul to the Galatians: Based on the Greek Text. 

 Edinburgh: T. & T. Clark, 1884; reprint, Minneapolis: James and Klock Christian 
 Publishing Co., 1977. 

 
Erasmus, Desiderius. Collected Works by Erasmus. Edited by John W. O'Malley. Vol. 66, 

 Enchiridion. trans. and annotated by Charles Fantazzi. Toronto: University of 
 Toronto Press, 1988. 

 
Flint, Thomas P., ed. Christian Philosophy. University of Notre Dame Studies in the 

 Philosophy of Religion, no. 6. Notre Dame, Ind.: University of Notre Dame, 1990. 
 
Freeman, Hobart E. An Introduction to the Old Testament Prophets. Chicago: Moody Press, 

 1968. 
 
Goppelt, Leonhard. Theology of the New Testament. Vol. 1, trans. John E. Alsup, ed. Jurgen 

 Roloff. Grand Rapids: Eerdmans, 1981.   
 
Gordon, Barry. The Economic Problem in Biblical and Patristic Thought. Supplements to 

 Vigiliae Christianae, vol. 9. Leiden: E.J. Brill, 1989. 
 
La Sor, William, David Allan Hubbard, and Frederic William Bush. Old Testament Survey: 

The Message, Form, and Background of the Old Testament. Grand Rapids: 
Eerdmans, 1982. 

 
 

[page number bottom centered for initial page] 
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APPENDIX B: Research Paper Checklist 
 
Structure of the Paper 
 
� Does your paper include a title page (title, name, course)? 
� Is your paper numbered, double-spaced, and stapled in upper left corner? 
� Have you footnoted all specific facts and unoriginal thoughts whether directly quoted or 

not? 
� Have you used the correct form for your footnotes and bibliography? 
� Did you include a bibliography at the end of the paper? 
� Are authors of all quotations identified in the text of the paper? 
� Have you used the correct form for direct quotations (quotation marks or indentations for 

long quotations)?   
� Have you followed the Seminary guide for form and style? 
 
Research 
 
� Have you consulted the minimum amount of sources required? 
� Have you relied on one source too heavily? 
� Have you concentrated on using primary sources for your research? 
� Do you have mostly general sources (i.e., encyclopedias, dictionaries) or do you include 

specific sources (i.e., journals, commentaries)? 
 
Grammar 
 
� Have you proof-read your paper? 
� Have you used the spell-check feature of your word processing program? 
� Have you used contractions, colloquialisms, slang, or exclamation points? 
� Have you referred to yourself as “I”, “we”, or “us”? 
� Have you used the same tenses within context consistently (e.g., past tense)? 
� Do you have subject-verb agreement? 
� Have you been consistent in your use of upper and lower cases? 
 
Style/Content 
 
� Do you have a clear and specific purpose clause? 
� Have you worked on having smooth transitions between your points? 
� Have you drawn conclusions from what you have studied? 
� Have you written in the active voice primarily? 
� Have you avoided jargon if possible? 
� Have you identified problems and other areas that could be explored? 
� Have you dealt with views that differ from your own? Have you been fair? Have you refuted 

their arguments? 
� Have you properly supported your position? In other words, have you provided the evidence 

necessary to support your position? 
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APPENDIX C: Common Flaws In Logic 

 
1. Begging the question: premise of the argument is the same as that which one is trying to 

prove. 
2. Ad hominem argument: attacking the individual instead of the validity or invalidity of 

what is believed. 
3. Ad Verecundiam argument: appealing to an illegitimate authority. 
4. Ad populum argument: supporting your position by appealing to commonly held 

principles. 
5. Non sequitur:  when you have not proven or demonstrated what you said you have just 

proven or demonstrated; an incorrect inference. 
6. Sweeping generalities:  confusing similarity with identity (‘similarity’ is ‘sameness’). 
7. “Good” guy / “Bad” guy mentality:  when one assumes that those that differ from him 

or her are essentially evil. 
8. Emotionalism:  when one makes an appeal aimed primarily to the emotions and not to 

the rationale processes. 
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APPENDIX D: Times New Roman Symbol Set 
 

1. In Microsoft Word for Windows, click on the “Insert” menu, then select Symbol. 
 

2. In the Symbol window, select “Times New Roman” from the Font pull-down menu 
on the left. 

 
3. Double Click a symbol to insert it into your document. 
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APPENDIX E: BibleWorks Greek and Hebrew Fonts 
 
The BibleWorks Hebrew Keyboard Map (BWHEBB) 
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